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Getting Started 
 
Microtrak Evolution.NET consists of easy to use, intuitive modules. They cover the main areas of operation - UUser ManagementU, 
UPersonnel ManagementU, UFacility ManagementU, UReal Time Monitoring U, UReportsU and optional UVisitor ManagementU. Each of these 
modules is designed to carry out specific tasks and display information appropriate to its function within the software. Between 
them, they enable every aspect of an access control application to be realised. 
 
The software has been designed for ease of use and as such its operation makes extensive use of both Drag and Drop and 
right click functionality - no need for lots of menu bar options although of course tasks can be carried out this way if required. 
The layout is in a familiar style which should aid navigation. 
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User Management 
 
The User Management module controls who can use the software. Templates describe which software modules are visible to an 
individual or group of individuals when the GUI is running, and a password is needed to open the GUI. Passwords can be fixed by 
the Administrator, or individuals can be allowed to change them. 
 
UAdd TemplateU 
 
UAdd User 
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User Management >Add Template 
 
To add a user template, click on the Add Template link in the navigation bar. Give it a name and description as required and click 
the OK button.  
 
Right click on the new template name in the navigation tree and select Edit Rights. Select the required rights for the template by 
clicking on the relevant module name in the Template window. 
 
Click on Apply when you have finished.  
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User Management >Add User 
 
To add a user, click on the Add User link in the navigation window. Give it a Username, First Name, Last Name, Password and 
Template as required and click the Add button. 
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Facility Management 
 
The Facility Management module is used to setup and manage the physical aspects of the system - the doors, barriers, readers 
and indicators. During the specification phase the doors to be controlled and the number of readers associated with each door 
will have been decided. It is often easier to create a diagram to show how these fit in and the floor plan of the building or 
buildings being controlled.  
 
UAdd Access ControllerU 
 
UAdd Door ControllerU 
 
UAdd AreaU 
 
UAdd ZoneU 
 
UAdd Time ProfileU 
 
UAdd Holiday PeriodU 
 
UAdd Override PeriodU 
 
UAdd Alarm HandlerU  
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Facility Management > Add Access Controller 
 
The Access Controller is a Windows service that communicates with many Door Controllers. It is responsible for keeping the 
time, operation and access rules of every Door Controller up to date and collecting data from the Door Controllers. Normally one 
Access Controller is required on each site. When Secured Zones are used, the Access Controller manages the zone rules. To do 
this it must be able to communicate with the Door Controllers assigned to a zone at all times.  
 
To add an access controller, click on the Add Access Controller link in the navigation window. Give it a Name and Description. To 
make it active on the system, tick the Active checkbox. 
 
The other criteria depend on the area controller having been setup previously. The ID String is the identifying name given to the 
area controller which is dictated in the AccessControllerService.exe.config file usually during installation. The IP Address is the 
network identifying address of the area controller service. The State indicates whether the area controller service is running or 
not. If it is not, no communication between the software and hardware will take place.  
 
To carry out any editing of the access controller parameters, right click on the controller in either the hardware tree or on the 
Structure Panel.  

 



MICROTRAK EVOLUTION.NET USER GUIDE 

 

8 

 

 
Facility Management > Add Door Controller 

A Door Controller is required for every door that is being controlled. Single Door Controllers contain sufficient resources to 
control one physical door. Dual Door Controllers can control two physical doors with entry readers only or one physical door with 
entry and exit readers. Door Controllers are programmed by the Access Controller according to the rules established by the GUI. 
The configuration details are remembered by each Door Controller, allowing them to always operate using the most recent 
access rules even when they cannot communicate with the Access Controller. 
 
When a Door Controller is connected to the network it must be configured using the Door Discover utility. It will then be added to 
the Hardware Hierarchy tree automatically. 
 
It is not normally necessary to add a Door Controller manually, but if required click on the Add Door Controller link in the 
navigation window. First check for reasons why it is not appearing automatically. In particular check for the following: - 
 
* The wrong Server ID or Server Port - they MUST match the IP address and port number of the Access Controller  
 
* Duplicate TerminalID - every Door Controller in the system MUST have a different ID  
 
* Exceeding the number of Door Controllers allowed by the current license  
 
After a door has been added it must be configured to suit the hardware connected to it. To carry out any editing of the 
parameters, right click on the controller in either the hardware tree or on the Structure Panel. 
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Facility Management > Door Controller Setup 
 
A Single Door Controller can control one physical door with entry and exit readers. Dual Door Controllers can control two physical 
doors with entry readers only or one physical door with entry and exit readers. 
 
Door Controllers shipped before November 2006 contain four inputs and five outputs. Later models contain eight inputs and eight 
outputs. Ticking or clearing the ‘Pre Nov06’ box alters how many Inputs and Outputs are available in the software.  
 
To carry out any editing of the door parameters, right click on the door in either the hardware tree or on the Structure Panel.  
 
Four icons are used to select the number of doors and readers controlled by each Door Controller. 
 

Add Door 

Remove Door 

Add Reader 

Remove Reader 

 
When an operation is not possible, the icon is greyed-out. When two doors are selected, the default arrangement is Reader 1 
attached to Door 1 and Reader 2 attached to Door 2.  
 
UGeneralU  
 
UMediaU  
 
UMiscellaneous U 
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Facility Management > Door Controller Setup > General 
 
Name: - the name of the door controller as it will appear in the software. 
 
Description: - an optional information field to add things like location details. 
 
ID: - the identity of the door controller. 
 
Active: - dictates whether the door is active on the system. 
 
State: - the current status of the door controller e.g. Running, Unknown etc... 
 
Firmware ver: - the current firmware in the door controller. 
 
IP Address: - the current IP address of the door controller. 
 
Last Contact Time: - the last time that the door controller communicated with the software. 
 
Access Controller: - the access controller that is handling this door controllers communications. 
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Facility Management > Door Controller Setup > Media 
 
Any of the most common types of media can be used to control access across the site. These are grouped into three common 
interfaces - Weigand, Clock/Data and Bar Code - and each type of interface supports a number of different standard decodes. 
The choice of interface is determined by the type of reader required for the site, and the choice of decode is determined by the 
formatting of the badge that has been issued. In most cases the same type of media will be used across the whole site. The 
Media tab allows the interface and decode to be selected to suit the media being used on the site.  
 
Media: - the type of reader interface that will be used with the door controller. The choices are Barcode*, Clock/Data and 
Weigand.  
 
Decode: - these options will change depending on the Media type selected and will be specific to the type of reader used  
 
Manipulation: - you can use this option to extract characters from the badge number. Only the selected character string will be 
used to confirm it is a valid badge. For example, a typical Weigand 26 bit format is SSS-DDDDD, where SSS is a site code and 
DDDDD is the badge number. To extract just the badge number, enter manipulation values of Start = 5, Length = 5. 
 
Up to five sets of values can be entered. 
 
Enable PIN Pad: - you can connect one PIN pad to a single door controller and two PIN pads to a dual door controller, using the 
optional auxiliary module.  If you check this option you can use the PIN pad to enter an ID, as an alternative to using a media 
reader. To use this option you must also specify the number of characters to be entered. 
 
* NOTE: an optional auxiliary module will be required for Barcode readers. Make sure that Barcode reader cables are connected 
to auxiliary module, and not to the connectors on the main board. 
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Facility Management > Door Controller Setup > Miscellaneous 

 

Timed Anti-Passback: - use this option to prevent an ID card from being re-used for a specified time. It is used as a deterrent 

against sharing an ID card among personnel. Tick the box to enable the facility and enter the required time (default is 10 

minutes). 

Multiple-swipe protection: - use this option to prevent an ID card from being re-used for a specified time or until a different ID 

card is used. It is used to protect against accidental re-reading of the same ID card. Tick the box to enable the facility and enter 

the required time (default is 10 seconds). 
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Facility Management > Door Controller Setup > Door Setup 
 
Inputs and outputs must be allocated to each door according to the plan created when the system is specified. This must be 
done carefully so it agrees exactly with how the hardware has been wired to the UDoor ControllerU. If possible, refer to the system 
diagrams while setting up the doors.  
 
UGeneralU  
 
UOperationsU  
 
UIndicatorsU  
 
UInputsU  
 
UTime ProfilesU  
 
UReadersU  
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Facility Management > Door Controller Setup > Door Setup > General 
 
Name: - the name of the door controller as it will appear in the software. 
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Facility Management > Door Controller Setup > Door Setup > Operations 
 
A door is controlled by following a set of rules for the hardware physically connected to the door. Typically these will include a 
relay to energise the door lock and inputs to monitor when the door is open. Sometimes an input from a fire alarm is used to 
unlock the door to help with evacuation. 
 
The Door Operations dialogue box specifies details for these tasks.  
 
 

Door Relay  
 
Ouput: - select which relay is controlled by this door. 
 
Latch time: - how long the relay is active (minimum resolution is 0.125 second). The default value of 4 seconds suits 
most situations. A shorter time may be used for motor driven turnstiles and barriers, and a longer time may be required 
for wheelchair access etc...  
 
Door Monitoring  
 
Ajar Time: - period of time that the door can be left open before generating an alarm (minimum resolution is 0.125 
second).  
 
Grace Time: - period of time between a successful door open action and generating a door forced alarm (minimum 
resolution is 0.125 second).  
 
Forced Time: - period of time that the door can be forced open before generating an alarm (minimum resolution is 
0.125 second).  
 

NOTE: These settings will be ignored if no input has been selected for monitoring the door. 
 
Fire Monitoring 
 
Alarm handler: - : select the name of the alarm handler to be used in response to an input from a fire alarm panel. An 
alarm handler specified for Fire Monitoring is treated with higher priority than other alarm handlers.  
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Facility Management > Door Controller Setup > Door Setup > Indicators 
 
Any of the outputs on the Door Controller can be used to indicate one of several states or events to the system users. Often they 
will be connected to the LED indicators on the reader, but may also be connected to other visible or audible alarms.  
 
Door Controlled: - the action that will occur when the door is in a controlled state. 
 
Door Open: - the action that will occur when the door is in an open state.  
 
Door Locked: - the action that will occur when the door is in a locked state.  
 
Door Forced: - the action that will occur when the door is forced open. 
 
Door Left Open: - the action that will occur when the door is left open.  
 
Egress: - the action that will occur when the egress button is pressed.  
 
For each of the above an Output can be selected from the drop-down list. Either eight or five outputs will be available, depending 
on the type of Door Controller. When an output is selected its action can be defined as ON or FLASH. A timed duration can be set 
or, if no duration is set, the action will continue until it is overridden or the Door Controller loses power. 
 
Alternatively the Door Violation and Egress events can initiate an alarm handler instead of using an output, by selecting the 
appropriate handler from the drop-down list.  
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Facility Management > Door Controller Setup > Door Setup > Inputs 

 

All of the inputs on the Door Controller can be programmed for different purposes. Some will be used to monitor or open 

individual doors, while others may be used to raise an alarm or alert a supervisor. 

 

Input Type: - there are several different input types.  

• Egress -used to activate the relay to open the door.  

• Monitoring - used to identify if the door is open or closed.  

• Response - used to trigger an alarm handler.  

• Free - only creates an event record in the real time monitoring logs.  

• Fire - used to trigger a high-priority response, typically to lock or unlock doors.  

 
Active: - the active state of an input can be Closed or Open.  
 
Alarm Handler: - this is a particular defined event that will happen when the input becomes active.  
 
Message: - a user definable message that will occur when the input is activated.  
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Facility Management > Door Controller Setup > Door Setup > Door Time Profiles 
 
Time profiles may be applied to individual doors to restrict or allow access at different times each day, or for a number of days 
such as national holidays.  
 
To apply a profile, use the mouse to Drag and Drop time profiles, holiday periods and override periods to each of the boxes - 
Always Open to allow access or Always Closed to restrict access. Multiple profiles can be applied to each door if required.  
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Facility Management > Door Controller Setup > Door Setup > Reader Setup 
 
A door can support one reader to control entry only, or two readers to control entry and exit. Details of each reader can be 
specified to suit the system plan. This must be done carefully so it agrees exactly with how the hardware has been wired to the 
Door Controller. If possible, refer to the system diagrams while setting up the readers.  
 
UGeneralU  
 
UIndicatorsU  
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Facility Management > Door Controller Setup > Door Setup > Reader Setup > General 
 
Name: - the name of the reader as it will appear in the software. This is useful when a door has two readers, such as Reception 
Door IN and Reception Door OUT. The default names are ‘Reader 1 (Door Controller name)’ and ‘Reader 2 (Door Controller 
name)’.  
 
Physical reader: - The Door Controller has two reader connectors (READER1 and READER2). Select one of the readers from the 
drop-down list, according to which Door Controller connector has been used. By default the physical reader 1 is attached to 
Reader 1 and physical reader 2 is attached to Reader 2.  
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Facility Management > Door Controller Setup > Door Setup > Reader Setup > Indicators 
 
Any of the outputs on the Door Controller can be used to indicate one of two reader events to the system users. Often they will 
be connected to the LED indicators on the reader, but may also be connected to other visible or audible alarms. 
 
Access Granted: - the action that will occur when a card is used on a reader and it passes all of the validity tests.  
 
Access Denied: - the action that will occur when a card is used on a reader and it fails one or more of the validity tests.  
 
For each of the above an Output can be selected from the drop-down list. Either eight or five outputs will be available, depending 
on the type of Door Controller. When an output is selected its action can be defined as ON or FLASH. A timed duration can be set 
or, if no duration is set, the action will continue until it is overridden or the Door Controller loses power.  
 
Alternatively, these events can initiate an alarm handler instead of using an output, by selecting the appropriate handler from 
the drop-down list.  
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Facility Management > Add Area 
 
To aid administration of the system, doors can be grouped together into Areas. Usually an area will relate to a department or 
physical location within the site. It is wise to give every Area a name that has meaning to the organizations management 
system, such as Sales Offices, IT Room, Accident & Emergency etc. An Area may have as few as one controlled door and doors 
may appear in more than one area. It is also possible to have areas within areas.  
 
To add an area, click on the Add Area link in the navigation window. Give it a Name and Description as required. Drag and Drop 
the required doors into the New Area window and then click on OK. To carry out any editing of the area, right click on the item in 
either the hardware tree or on the Structure Panel.  
 
NOTE: Doors must be added to an area before access control can be implemented. 
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Facility Management > Add Zone 
 
If there is a need to know who is in a specific room or location then the Zone feature can be used. A Zone is a special Area that 
has defined in and out readers, thus it is possible to maintain a log of who is within the zone. It is important that the doors 
associated with a Zone are permanently controlled. A Zone can be secured to prevent badges from being passed from one user 
to another. A user cannot enter a secured Zone if the badge is already logged as being in the Zone, or from a non-adjacent 
Zone.  
 
To add a zone, click on the Add Zone link in the navigation window. Give it a Name and Description as required. Drag and Drop 
the required readers into the New Zone window and designate them as either In or Out readers. Click on OK.  
 
To make the zone secure, tick the Secured checkbox.  
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Facility Management > Add Time Profile 
 
A Time Profile defines one or more period for every day of the week. Typically, they are used to restrict or allow access at 
different times of day on a regular basis and do not make any reference to the date. Different time profiles may be set up for 
different groups of people, so it is wise to choose a description that has meaning to the organizations management system, such 
as Normal Office Hours, Admin Staff, Visitors etc. A Time Profile can contain more than one period within the same day, and 
periods can be copied from one day to another.  
 
To add a profile, click on the Add Time Profile link in the navigation window. Give it a Name and Description as required. Use the 
mouse to Drag and Drop the required start and end times for the profile in the Time Profile window. Fine adjustment can be 
carried out in the Start time: and End time: combo boxes.  
 
There are extensive 'right click' options here as well.  
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Facility Management > Add Holiday Period 
 
A Holiday Period defines a period with a start and end date. Normally the time is set for 'all day' but this can be changed if 
required. Multiple dates can be defined in a single Holiday Period and they can be consecutive or random. Alternatively, separate 
Holiday Periods may define each separate date. For example, Christmas and Easter can be defined as separate Holiday Periods, 
or grouped in a single Holiday Period defining all public holidays. A Holiday Period will normally be used to restrict access when 
the organization is closed.  
 
To add a period, click on the Add Holiday Period link in the navigation window. Give it a Name and Description as required. Use 
the mouse to Drag and Drop the required start and end dates for the period in the New Holiday Period window. By default every 
day of a holiday period is a full day. To alter the time use the mouse to drag and drop the bar to the required time - fine 
adjustment can be carried out in the Start time: and End time: combo boxes. You can add as many individual dates or groups of 
dates to a period as required.  
 
Click on the Add link and it will be added to the system.  
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Facility Management > Add Override Period 
 
An Override Period defines a period with a start and end date. Normally the time is set for 'all day' but this can be changed if 
required. Multiple dates can be defined in a single Override Period and they can be consecutive or random. Alternatively, 
separate Override Periods may define each separate date. Override Periods are used in the same way as Holiday Periods except 
they are used to allow temporary changes to the normal Time Profile. For example holiday cover or temporary overtime.  
 
To add a period, click on the Add Override Period link in the navigation window. Give it a Name and Description as required. Use 
the mouse to Drag and Drop the required start and end dates for the period in the New Override Period window. By default every 
day of an override period is a full day. To alter the time use the mouse to drag and drop the bar to the required time - fine 
adjustment can be carried out in the Start time: and End time: combo boxes. You can add as many individual dates or groups of 
dates to a period as required.  
 
Click on the Add link and it will be added to the system.  
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Facility Management > Add Alarm Handler 
 

A fire alarm input can be connected to one or more door controllers, which then controls the operation of any number of 
doors according to rules established in an alarm handler. The door controller to which the input is connected will respond 
to the alarm directly, even if it is no longer communicating with the software. The other door controllers must be 
communicating with the software in order to respond to the alarm. Any number of door controllers can trigger the same 
alarm handler but if the handler is generating printouts or emails, make sure it is only triggered by one door controller.  
 
To add a handler, click on the Add Alarm Handler link in the navigation window. Give it a Name and Description as 
required. Select the required actions from the available options.  
 
NOTE: the Alarm Handler will be ignored if no fire input has been selected for the door. 
 
UE-mailU 

 
UMessage BoxU 
 
UDoor State OverrideU 
 
UOutputs U 
 
UReportsU 
 
UNetworkU 
 
UZones ClearU 
 
Click on OK and it will be added to the system.  
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Facility Management > Add Alarm Handler > E-mail 
 
This option allows an email to be sent to the specified address with a particular message when the alarm handler is invoked.  
 
To enable this option, tick the Enable checkbox. Add the other details as required.  
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Facility Management > Add Alarm Handler > Message Box 
 
This option allows a dialog box to appear with a particular message when the alarm handler is invoked.  
 
To enable this option, tick the Enable checkbox. Add the other details as required.  
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Facility Management > Add Alarm Handler > Door State Override 
 
This option allows any door on the system to perform a specified action when the alarm handler is invoked.  
 
To enable this option, tick the Enable checkbox. Select the doors that you want to control with the handler. Choose the action 
that you wish to occur from Controlled, Locked or Open.  
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Facility Management > Add Alarm Handler > Door State Outputs 
 
This option allows any of the door controller outputs and/or relays to be operated when the alarm handler is invoked.  
 
To enable this option, tick the relevant checkbox that applies to the output you wish to generate. Choose from Relay 1, Relay 2, 
Output 1, Output 2, Output 3, Output 4, Output 5, Output 6, Output 7 or Output 8. 
 
The available output actions are None, On, On (timed), Flash, Flash (timed) or Off.  
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Facility Management > Add Alarm Handler > Reports 
 
This option allows a report to be generated when the alarm handler is invoked.  
 
To enable this option, tick the Enabled checkbox and then select the report you wish to run from the list. 
 
NOTE: No reports will be listed if they have not been previously setup.  
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Facility Management > Add Alarm Handler > Network 
 
This option allows a message to be sent for use by an external program. The IP Address, Port number and Message type can be 
specified.  
 
To enable this option, tick the Enable checkbox. Add the other details as required.  
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Facility Management > Add Alarm Handler > Zones Clear 
 
This option allows a zone to be automatically cleared after a specified input is activated. 
 
To enable this option, tick the Enable checkbox and then the checkbox against the required zone in the list.  
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Personnel Management 
 
The Personnel Management module is used to setup and manage the people in the system. An individual person can be added to 
the system using the Add Person dialogue box, or groups of people can be added using Import Person List from the File menu. 
 
After a person has been added to the personnel database their name will appear in the personnel list. Once in the list they can 
be assigned access rights that determine where and when they are allowed to go around the site. A photograph can be 
associated with each user, either from a file or a local camera. A person is normally assigned access rights as a member of a 
UPersonnel GroupU.  
 
UAdd PersonU 
 
UAdd Personnel GroupU 
 
UAdd Badge DesignU 
 
UAdd Time ProfileU 
 
UAdd Holiday PeriodU 
 
UAdd Override PeriodU 
 
UConfigure Additional InformationU  
 
UZone AttendanceU 
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Personnel Management > Add Person 
 
To add a person click on the Add Person link in the navigation window.  
 
UGeneralU 
 
UDetails U 
 
UAdditional InformationU 
 
When these details have been added, click on the OK button to add the individual to the system.  

 
NOTE: An existing list of personnel can be added via the Import Person List option that is available under the File menu.  
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Personnel Management > Add Person > General 
 
Enter the General details into the relevant fields - Title, First Name, Last Name*, Initials*, Card ID* and PIN as required. 
 
If the Personnel group already exists, select it from the drop down list. 
 
NOTE: The three asterisked fields - Last Name, Initials and Card ID - are mandatory. The OK button is unavailable until these 
three fields have been populated. 
 
The other fields are optional, but they are often helpful when searching for people in the database. The PIN is used in addition to 
the Card ID to provide additional security for sensitive areas or at particular times of day.  
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Personnel Management > Add Person > Details 
 
Click on Details to add access right information - Status, Access granted from, Access granted until and Unlimited Access as 
required. 
 
Select the persons Status from the drop-down list - Permanent (default), Visitor, Contractor and Part Time. The status field can 
be used to filter logs and reports. 
 
Select a date using the drop-down calendar in the Access granted from box. The default is the current days date. Tick the 
Unlimited Access box or select a date in the Access granted until box. The default is Unlimited. 
 
The Department field is used to separate people on a Zone Report, and is particularly useful when the report is printed for use as 
a fire muster list.  

 
When these details have been added, click on the OK button to add the individual to the system.  
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Personnel Management > Add Person > Additional Information 
 
This allows you to enter details into custom specified fields that have previously been configured via the UConfigure Additional 
InformationU option.  
 
When these details have been added, click on the OK button to add the individual to the system.  
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Personnel Management >Add Personnel Group 
 
Personnel Groups allow people with the same work patterns to be given the same Uaccess rightsU. Personnel Groups can relate to 
individual departments, shifts or job functions. A Personnel Group defines Areas within the site, and the Time Profiles that apply 
to each Area. Holiday Periods and Override Periods can alter the normal working pattern by either denying or allowing access 
between specified dates. When a change is made to the access rights of a Personnel Group it will apply to everyone who is a 
member of that group. Personnel Groups can be nested to make new groups.  
 
Click on the Add Personnel Group link in the navigation window.  
 
Enter the required Name: and any Description:. 
 
Drag and Drop an Area from the Objects View onto the New Personnel Group to create a bar for that Area. The first field of the 
bar will show the name of the area. You can add as many areas as required to a personnel group. 
 
Drag and Drop UTime ProfilesU onto the second field, UHoliday PeriodsU onto the third field and UOverride PeriodsU onto the fourth field 
of each bar, as required. You can add as many profiles and periods as you like to each area.  
 
An icon appears in the field when it is populated. 
 

icon means access is allowed. 
 

icon means access is denied.  
 
By default access is allowed for time profiles and override periods, and denied for holiday periods. Clicking on the icon toggles its 
state.  

 
To remove an item from the bar, right-click on its name and select Remove.  
 
When these details have been added, click on the OK button to add the group to the system. It will appear in the tree on the left.  

 
Access Rights 
 
A person is normally assigned access rights as a member of a Personnel Group by right-clicking their entry in the list and 
selecting Choose Rights. All of the personnel groups that have been created will be visible. Selecting None will prevent that 
person from using the system. 
 
Alternatively a person can be assigned custom access rights by right-clicking their entry in the list and selecting Custom Rights. 

A dialogue similar to Add Personnel Group opens and is used in exactly the same way except it will not appear in the objects 
tree, and cannot be used for other personnel. The word Custom will appear in the Personnel Group column of the personnel list, 
instead of a personnel group name. 
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Personnel Management > Add Badge Design 
 
The optional Badge Production module allows different badges to be designed and printed to suit the site management.  
 
Click on the Add Badge Design link in the navigation window.  
 
Enter the required Name: and any Description:. 
 
Using the available design tools from the menu bars that will appear, produce the design required on the area in New Badge 
Design window. Text, Barcodes, Boxes, Circles and Images can all be added to the design. Data sources for text, magstripes and 
barcodes can be specified. 
 
Designs can be saved to either the database or as a file. If saved to the database, the design will appear in the tree. This can 

then be assigned to an individual or multiple personnel via Drag and Drop. 
 
NOTE: Designs are saved to the database by default.  
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Personnel Management > Add Time Profile 
 
A Time Profile defines one or more periods for every day of the week. Typically, they are used to restrict or allow access at 
different times of day on a regular basis and do not make any reference to the date. Different time profiles may be set up for 
different groups of people, so it is wise to choose a description that has meaning to the organizations management system, such 
as Normal Office Hours, Admin Staff, Visitors etc. A Time Profile can contain more than one period within the same day, and 
periods can be copied from one day to another.  
 
To add a profile, click on the Add Time Profile link in the navigation window. Give it a Name and Description as required. Use the 
mouse to Drag and Drop the required start and end times for the profile in the Time Profile window. Fine adjustment can be 
carried out in the Start time: and End time: combo boxes.  
 
There are extensive 'right click' options here as well.  
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Personnel Management > Add Holiday Period 
 
A Holiday Period defines a period with a start and end date. Normally the time is set for 'all day' but this can be changed if 
required. Multiple dates can be defined in a single Holiday Period and they can be consecutive or random. Alternatively, separate 
Holiday Periods may define each separate date. For example, Christmas and Easter can be defined as separate Holiday Periods, 
or grouped in a single Holiday Period defining all public holidays. A Holiday Period will normally be used to restrict access when 
the organization is closed.  
 
To add a period, click on the Add Holiday Period link in the navigation window. Give it a Name and Description as required. Use 
the mouse to define the required start date, end date and time for the period. Fine adjustment to the time can be carried out in 
the Start time: and End time: combo boxes. 
 
Click on the Add link and it will be added to the profile. Click on OK to add it to the system.  
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Personnel Management > Add Override Period 
 
An Override Period defines a period with a start and end date. Normally the time is set for 'all day' but this can be changed if 
required. Multiple dates can be defined in a single Override Period and they can be consecutive or random. Alternatively, 
separate Override Periods may define each separate date. Override Periods are used in the same way as Holiday Periods except 
they are used to allow temporary changes to the normal Time Profile. For example holiday cover or temporary overtime.  
 
To add a period, click on the Add Override Period link in the navigation window. Give it a Name and Description as required. Use 
the mouse to define the required start date, end date and time for the period. Fine adjustment to the time can be carried out in 
the Start time: and End time: combo boxes. 
 
Click on Add. Click on OK and it will be added to the system.  
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Personnel Management > Configure Additional Information 
 
This option allows extra fields to be added to the database for any custom information required. e.g. car registration, telephone 
number etc...  
 
Click on the Add field link and enter the required field name into the Name text box and then select the Type of field from the 
available options in the drop down box.  
 
To remove a field, click on the Remove field link.  
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Personnel Management > Zone Attendance 
 
To manually manipulate people in a zone, right click on the Zone Attendance window. 
 
Add person to zone: You can add a person or people to a zone simply by selecting them from the list and then picking the 
required zone from the drop down box. Click on OK and they will be added.  
 
Move person to zone: You can move a person or people to a different zone simply by highlighting them in the Zone Attendance 
window, right clicking and selecting the required zone under the Move person to zone option.  
 
Remove person from zone: You can remove a person or people from a zone simply by highlighting them in the Zone Attendance 
window, right clicking and selecting the Remove person from zone option.  
 
Clear zone: You can clear a zone completely simply by right clicking on the Zone Attendance window and selecting the required 
zone under the Clear zone option.  
 
To change the viewing options of the Zone Attendance window, use the toolbar on the right hand side.  
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Real Time Monitoring 
 
The Real Time Monitoring module allows different aspects of how the system is being used to be viewed in real-time. Details of 
what is displayed, and how it is ordered can be configured to suit specific requirements. The main window shows all events and 
separate windows can be used to view events associated with system changes, door access, zone attendance and alarms. 
 
To configure the columns to be shown, right click on the All Events window and select Configure columns.... The columns to be 
made visible and/or hidden can be selected from the Column configuration dialog box. 
 
To use the Add/Edit Events option, click on the link in the menu and then the Add new window link in the Events window editor 
dialog box. Change the title field as required (by default it is named: New event window 1). Select Local if you want the new 
window to be shown as a tab. If not it will be a new separate window. Select one or more checkboxes in access group and/or 
alarm group and/or system group. Click on OK when finished. 
 
The new window will have been created and displayed in the way chosen. Configure the columns to be displayed as previously 
described.  
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Reports 
 
The Reports module allows reports to be set up according to the type of data that is being analysed. A report may be executed 
immediately after it has been configured and it can be named and saved in the tree. Any number of configurations of each report 
may be saved and re-used as often as required. 
 
NOTE: that most reports include dates which may need to be updated before re-use. Reports can be viewed on screen and can 
also be printed to one or more printer.  
 
There are an amount of pre-configured Simple Reports available: Badge Activity, Booked Visitors, Card Expiry, Door Activity, 
Hardware, Last Badge Events, Personnel Group, User Activity, Visitor History, Visitors On Site and Zone Report. To use one of 
these, right click on it in the navigation window and select Add Report. The New Report dialog will appear with the selected filter 
criteria. Give the new report a Name and Description as required and specify the times and dates to be used.  
 
To produce the report immediately, click on the Execute link. To save the report for future use, click on the OK button. 
 
To setup how the report will be displayed, click on the HUPage setup...UH link.  
 
To filter the columns shown in any report, click on the arrow next to the column heading. The report content can be made visible 
or hidden by clicking on the '+' or '-' symbols.  
 
A report can be exported in either xls or pdf formats. To do this simply right click on the report results and select Export.  
 
To print the report, right click on the results and select Print.  
 
HUAdd ReportUH 
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Reports > Add Report 
 
To add a custom report, click on the Add Report link. From the New Report dialog box, give the report a Name and Description 
and select the period of time it is to cover with the From and To drop down calendars. Select the criteria required for this report 
from the grouped events in the boxes on the left. Then select the fields to be displayed in the report from the options that 
appear on the right by ticking the appropriate checkboxes. To setup how the report is displayed, click on the HUPage setup...UH link.  
 
Click on the OK button to save the report. It will appear in the list. 
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Reports > Page setup... 
 
This shows the printers installed on the system. As long as the printer is in the windows Control Panel and has been installed 
correctly, it will be shown here.  
 
Select the printer or printers that the report should be printed to by ticking the appropriate checkboxes. To access the standard 
printer setup dialog, click on the relevant Setup button.  
 
HUColumns SetupUH 
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Reports > Page setup... > Columns Setup 
 
This allows the content of the report to be controlled by choosing the required columns.  
 
Select the columns to be displayed by ticking the relevant box in the Visible columns list. The selected columns will appear in the 
Column edit list and can be moved up or down and the width dictated as required. The width is shown as a percentage. When 
one width is adjusted, the others may adjust automatically, so some experimentation may be needed to achieve the best result.  
 
The font and colour can be setup individually for the header and content of each column.  
 
Click on OK to accept the settings. That report will now always be processed to those criteria unless they are edited. 
 
NOTE: Dependent on the report type, columns are not always editable in this way. 
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Reports > Printing 
 
The Reports can be printed to an individual or multiple printers. As long as the printer is in the Windows® Control Panel and has 
been installed correctly, it will be available to the software.  
 
To print a report right click on it and select Print. To review how the report will printout, right click on it and select Print Preview. 
To change how the report will print, right click on it and select Page Setup. 
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Visitor Management 
 
The Visitor Management module is used to setup and manage any current or potential visits in the system. An individual visitor 
can be assigned access rights, issued with a badge and/or booked onto site temporarily either in real time or in advance. The 
separation of visitors and personnel enables total control of the system to be kept with the administrator whilst visitors can 
typically be dealt with by reception and security.  
 
After a visitor has been added to the database their name will appear in the Visitors list. Once in the list they can be assigned a 
visit and this will appear in the Visits list with its status - Pending, Visiting or Completed. From here they can Sign In or Sign Out 
of the system.  
 
Visitor movements can be tracked and it can be established who is on site at all times. Analysis of visitor trends can be viewed in 
the UReportsU section.  
 
UAdd VisitorU 
 
UBook VisitU 
 
UAdd Pre-printed BadgeU 
 
U 
UConfigure Additional InformationU  
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Visitor Management > Add Visitor 
 
To add a visitor click on the Add Visitor link in the navigation window.  
 
UGeneralU 
 
UCreate BadgeU 
 
UAdditional InformationU 
 
When these details have been added, click on the OK button to add the individual to the system. 
 
The visitor will appear in the Visitors list. Visitors can be filtered by company name, last name, first name and visitor's type. To 
remove or edit a visitor, right click on the required one in the Visitors list and select the appropriate option.  
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Visitor Management > Add Visitor > General 
 
Enter the General details into the relevant fields - Title, First Name*, Last Name*, Initials*, Type, Company and Department as 
required. Click on the Add Visitor button and the record will appear in the Visitors list.  
 
NOTE: The asterisked fields - are mandatory. The Add Visitor button is unavailable until these fields have been populated. 
 
After adding the number of visitors required, click on the OK button.  
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Visitor Management > Add Visitor > Create Badge 
 
Click on Create Badge to add badge and access right information - Assign Badge, Assign Rights and Card ID.  
 
Select the badge design to be used from the Assign Badge drop-down list. This list will only show pre-existing designs.  
 
Select the access rights for this visitor from the Assign Rights drop down list of available Personnel Groups. It is good practice to 
have a group entitled Visitors to avoid any confusion. 
 
Type the required badge identity into the Card ID text box. 
 
The Select Photo... button allows an existing photograph to be added to the badge. The Capture Photo... button allows an 
attached capture device to take a photograph.  

 
The Print Preview... button allows a badge to be viewed before printing. The Print... button will print the badge to the designated 
badge printer.  

 



MICROTRAK EVOLUTION.NET USER GUIDE 

 

57 

 

 
Visitor Management > Add Visitor > Additional Information 
 
This allows you to enter details into custom specified fields that have previously been configured via the UConfigure Additional 
InformationU option.  
 
When these details have been added, click on the OK button to add the individual to the system.  
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Visitor Management > Book Visit 
 
To book a visit click on the Book Visit link in the navigation window. This will open the Book Visit dialog box. Find the person to 
whom the visit is to be assigned by using the Company filter if necessary and select them from the Visitor list. Select a Visiting 
person from the drop down list. Enter a the vehicle registration number (if applicable) into the Vehicle No text box. 
 
Select the visit date from the Visit calendar by clicking on the required day. If the visit is over a period of days a date range can 
be entered by clicking on the start date and then clicking on the end date as required. The system will not add a visit if the date 
has already been allocated to that visitor. To see if any existing visits are booked for the date/s selected, click on the Show/Hide 
Booked Visits button. Click on the OK button or to assign further visits, the Book Visit button. Assign other visits as required and 
click on the Cancel button to close the Book Visit dialog box. 
 
The visit will appear in the Visits list with its status - Pending, Visiting or Completed. Visits can be filtered by company name, 
vehicle reg, visit date and status. To remove or edit a visit, right click on the required one in the Visits list and select the 
appropriate option.  
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Visitor Management > Add Pre-printed Badge 
 
If it is required that pre existing visitor badges are to be used with the system, they can be added to the system as Pre-printed 
Badges. Every badge that is added can be assigned to a visitor. The system will display which badges are in use and which are 
available at any one time. A badge cannot be re-assigned to another visitor until returned.  
 
Click on the Add Pre-printed Badge link and enter the required Badge name and the Card ID. The card ID is the number that is 
encoded onto the badge and is valid on the system.  
 
When these details have been added, click on the OK button to add the badge to the system. 
 
The badges will appear in the Pre-printed Badges list which can be filtered by available badges and badges in use. To remove or 
edit a badge, right click on the required one in the Badges list and select the appropriate option.  
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Visitor Management > Configure Additional Information 
 
This option allows extra fields to be added to the visitor management module for any custom information required. e.g. contact 
number etc...  
 
Click on the Add field link and enter the required field name into the Name text box and then select the Type of field from the 
available options in the drop down box.  
 
To remove a field, click on the Remove field link.  

 



MICROTRAK EVOLUTION.NET USER GUIDE 

 

61 

 

 

Troubleshooting 
 
Here are a list of questions and answers that will help with the operation of the Microtrak Evolution.NET software. Please refer to 
the relevant support sources for assistance with other products. 
 
The software will not open when started - it shows a 'Connection Error, Failed to connect to server' dialog box:  

• Ensure that the Microtrak Evolution Service is running in Control Panel>Administrative Tools>Services 

The software will not open after restarting the computer it resides upon:  

• Ensure that the Microtrak Evolution Service is running in Control Panel>Administrative Tools>Services. 

• Edit the MEService.exe.config file in the Program Files>Feedback Data Ltd>Microtrak Evolution.NET>Service folder. 
Increase the CheckDatabaseAttempts value. (The service will need to be restarted after this). 

The Area Controller is shown as 'inactive' in the software:  

• Ensure that the Access Controller Service is running in Control Panel>Administrative Tools>Services. 

• Ensure that the 'Active' checkbox is ticked in the Access Controller properties dialog. 

• Edit the AccessControllerService.exe.config file in the Program Files>Feedback Data Ltd>Microtrak 
Evolution.NET>AC folder. Increase the CheckDatabaseAttempts value. (The service will need to be restarted after 
this). 

A Door Controller does not appear automatically within the software:  

• Ensure that the Access Controller Service is running in Control Panel>Administrative Tools>Services. 

• Ensure that the 'Active' checkbox is ticked in the Access Controller properties dialog. 

• Ensure that the correct Server ID or Server Port has been assigned to the Door Controller - they must match the IP 
address and port number of the Access Controller. (Check using the Door Discovery utility)  

• Ensure that the TerminalID has not been duplicated - every Door Controller in the system must have a different ID. 
(Check using the Door Discovery utility)  

• Ensure that the number of Door Controllers allowed by the current license has not been exceeded.  

No transactions are appearing in the software:  

• Ensure that the Access Controller Service is running in Control Panel>Administrative Tools>Services. 

• Ensure that the Door Controllers are part of an UAreaU in the software. 

• Ensure that the Door Controllers are set as Active in the software. 

• Ensure that the Door Controllers have the correct UMedia TypeU setup in the software. 

• Ensure that the cabling connections between the reader and the Door Controllers are correct. 

• Ensure that the media being used is the correct type for the reader and has valid data encoded on to it. 

No transactions are appearing in the software from a particular Door Controller:  

• Ensure that the Door Controller is part of an UAreaU in the software. 

• Ensure that the Door Controller is set as Active in the software. 

• Ensure that the Door Controller has the correct UMedia TypeU setup in the software. 

• Ensure that the cabling connections between the reader and the Door Controller are correct. 

• Ensure that the media being used is the correct type for the reader and has valid data encoded on to it. 
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Contact Us  
 
For further information about Feedback Data and the range of products that we offer, go to our web site at: 
 
HUwww.feedback-data.comUH 
 
It also offers an extensive support section including: downloadable software, manuals, product information and remote sessions.  
 
You can e-mail our Technical Services department at: 
 
HUsupport@feedback-data.comUH or fill in the online forms on the website.  

 
 


